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Registration & Login for Members

This guide provides step-by-step instructions for registering and logging into your
account. It highlights the importance of timely registration to ensure a smooth
transition and offers troubleshooting tips for common issues, such as not receiving
the invitation email. Additionally, it includes contact information for support, making
it a valuable resource for a seamless user experience.

*** Registration & Login

1 Step

Creating Your Account
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2

3 Contacts responsible for Membership Ticket Receiving, as well as other authorized
member users with current accounts in legacy Newtin applications—including the
Positive Response website, Polygon/Grid maintenance, and Member
Administrator accounts—will receive an invitation to register within Exactix.

The registration email will be sent to the email address on record from
exactix@colorado811.org. To ensure that this email is delivered without issues,
please add this address to your organization's permitted sender or whitelist.

mailto:exactix@colorado811.org
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4 Please note this system does not support Internet Explorer.

5 To complete registration, click the "here" link provided, or if you are not
comfortable clicking the link in this email, you can copy and paste this URL into
your browser: https://exactix.colorado811.org/link-login/CO811/62c3fdb8-89a2-
11f0-9daf-e6a2b60cfa60

This will open the Exactix "Create Login" page.

https://exactix.colorado811.org/link-login/CO811/62c3fdb8-89a2-11f0-9daf-e6a2b60cfa60
https://exactix.colorado811.org/link-login/CO811/62c3fdb8-89a2-11f0-9daf-e6a2b60cfa60
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6 If assistance is needed for account setup or login, click on the "website" link at the
bottom of the email or go to https://www.colorado811.org/contact-us/

7 Your username will be your email address, and it should already be populated in
the "username field" for convenience.

Create a password, and then re-enter it to confirm. Click "Submit".

Suppose you already have an Exactix account from another state's 811 center. In
that case, you can click on the "Already have a login on this or another Exactix
system?" and follow those simple instructions to connect the new Colorado 811
Exactix to your existing Exactix account.

https://www.colorado811.org/contact-us/
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8 Once logged in you will arrive at your Colorado 811 Exactix dashboard!

*** Dashboards

9
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Dashboard Navigation

10 Step

11 Using the icons on the top right, you can customize your dashboard color.
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12 You can adjust the text size on your dashboard.

My Profile Dashbaord

13
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14 The person icon will allow you to access your profile information. You can sign out,
change your password, and view your profile.

15 Within your profile's "Basic" tab, you can verify information such as name spelling,
email addresses, phone numbers, and even browser information! If you find any
discrepancies, please get in touch with member-services@co811.org to update
your profile information.
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16 Within your profile's "Audits" tab, you will see all and any changes that have ever
been made to your profile.
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17 Within your profile's "Security" tab, you can view your username for logging into
Exactix, your email address for notices from Exactix, and the Role (s) (if any) that
have been assigned to you within Exactix. Roles in Exactix determine which
features and functions users can access. Users may have multiple roles assigned
to their account, allowing for higher levels of access and additional capabilities as
needed.

The "Security" tab will also display your API key if you are using the JSON API
method to post positive responses.

Explore our additional training materials on Roles to discover what
Membership-Basic, Membership-Standard, and Membership-Advanced Roles
offer. These resources will help you understand the features and access levels
each Role provides within Exactix, ensuring you get the most out of your
membership.



Made with Scribe - https://scribehow.com 11

18 Also, from within your Profile's "Security" tab, you can change your email address
used for notices from Exactix and/or change your password for Exactix by clicking
on the three-dot menu icon next to your username.

Your Exactix Username cannot be changed. If you need to change your username,
please get in touch with Member Relations via email at
member-services@co811.org.

mailto:member-services@co811.org
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19 To Change Email - This changes the email address that Exactix uses to
communicate with you. This does not change your Username.

Enter the new email address, next confirm the email address, and click "Set
Email". This will automatically send an email from mail@4iqidentity.com to the
new email address provided with a code to verify the new email address.

20 Sample verification email from mail@4iqidentity.com

mailto:mail@4iqidentity.com
mailto:mail@4iqidentity.com
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21 Verify the new email by entering the code provided in the verification email
received, and click "Confirm Email". If the email address for notices received from
Exactix has been updated and verified successfully, it will display that on your
profile's "Security" tab.

22 To Change Password - This changes the password used to log into Exactix.

Enter your old Exactix login password, then enter the new password (6 characters
or more). Next, confirm the new password and click "Confirm".
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23 Forgot Password or Username - If you forget your Exactix Username and/or
Password, there is a "Reset/Forgot Password" link on the Exactix login page at
https://exactix.colorado811.org/login.

https://exactix.colorado811.org/login
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24 Resetting Password - If you know your Username, enter it and click "Send code"
to receive a verification code to your Exactix email address, which is used for
notifications. This verification email will come from mail@4iqidentity.com. Enter
the code to reset your password.

If you do not know your Username, you can click on "Forgot Username," which
will allow you to enter an email address that Exactix will send an email to with the
username and verification code that can be used to access your account.

mailto:mail@4iqidentity.com
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25 The next tab in your profile is the "Contact Of" section, which displays the
different areas in Exactix where you may be listed as a contact. People can be
contacts in Exactix as an Excavator who submits tickets, a contact at a locate ticket
receiving Destination, a membership billing contact which would be shown under
the "Members" section, and/or as a contact on "Service Areas" which are the
member service area code(s) you have access to, and finally as a Ticket
Management System third party contact which would be under "Service
Provider"
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26 The last tab within your Exactix profile is the "Files" tab. This area displays any files
uploaded by Colorado 811 Member Relations to your Exactix account.

This completes the review of the Member login process and your profile within
Exactix! If you have any questions or concerns or if any of the information is
incorrect, please contact Colorado 811 Member Relations at
member-services@co811.org or 303-232-1991 for assistance.

Tickets Dashboard

mailto:member-services@co811.org
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27

28 To access your Ticket Dashboard on Exactix, you can click on either the "Go to
Ticket Dashboard" button or the "Tickets" section on the banner on the left side
of the Exactix homepage.
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29 The Ticket Dashboard will open to your "Service Area Tickets" section. These are
all of the tickets for your service area(s) that were created in the past 60 days.
There is a small dot icon next to the "Service Area Tickets" section, which
displays the total number of tickets in this section of your Ticket Dashboard.

30 The following section listed on your Ticket Dashboard is the "Response Due"
section. These are all of your service area(s) tickets that are due in 48 hours. There
is a small dot icon next to the "Service Area Tickets" section, which displays the
total number of tickets in this section of your Ticket Dashboard.
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31 The following section listed on your Ticket Dashboard is the "Past Due" section.
These are all of your service area(s) tickets that have not received a positive
response yet and are past the locate-by date. There is a small dot icon next to the
"Service Area Tickets" section, which displays the total number of tickets in this
section of your Ticket Dashboard.
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32 The next section listed on your Ticket Dashboard is the "Tickets on Map" section.
This section allows you to see your service area(s) tickets that were created within
the last 14 days, displayed as points on a map. See the "Tickets on Map" section of
this guide for a more detailed look at the Tickets on a Map section.

33 The final section listed on your Ticket Dashboard is the "All Responses" section.
These are all of the positive responses that have been posted to your service
area(s) tickets. There is a small dot icon next to the "Service Area Tickets"
section, which displays the total number of ticket responses in this section of your
Ticket Dashboard.
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34 Every section of your Ticket Dashboard, except the Tickets on Map section,
features a "Filter by Ticket Number" field where a ticket number can be entered
and searched for to locate it quickly. Each of the sections (except for the Tickets on
Map section) will also have a few icons below the ticket filter field for "Exporting"
what is displayed on that page, "Refreshing" the page, and "Toggle Map".
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35 A fourth icon will appear once a ticket, or several tickets, have been checked,
which is "Add Response."
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36 The "Toggle Map" icon, which resembles a small sphere, displays a map on the
right side of the screen showing the tickets currently on the list you are viewing. If
one or more of the tickets are checked, then that ticket will be displayed on the
map in red, while all unchecked tickets will be displayed in blue. As the map view is
adjusted, the list of tickets in the shown list will also change to match the new map
view.

The map has features like zoom in, zoom out, search (magnifying glass on the top
left corner of the map), a measurement tool, a 'place a pin' tool, position to
current location (must have location services on your device turned on for this
feature to work), well and facility map layers, and aerial imagery. Refer to the
"Tickets in Map" information below for a more in-depth examination of the map
features, as the "Toggle Map" icon and the "Tickets on Map" map share the
same available features.
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37 Every section of your Ticket Dashboard, except for the "Tickets on Map" section,
features a page index and the ability to adjust the number of items listed per
page, located at the top right of the ticket list.

In addition, every section, except for the "Tickets on Map" section, that includes
column data, can be filtered per column. Each of the column headers is a clickable
link that will open a pop-up with filter parameters that can be set.
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38 To open a column filter, click on the column header you want to filter by, make
your filter selections, and then click anywhere outside the filter pop-up to close it
and apply the filter. Each column has its own filtering capabilities, and multiple
column filters can be set as needed.

The "Current Response" column filter lets you pick what positive response(s) you
would like to filter to.

39 The "Response Due Date" column filter allows you to filter by the ticket's
response due date (the locate-by date).
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40 The "Street" column filter allows you to search for a specific address or street and
filter results in ascending or descending alphabetical order.

41 The "Place" column filter lets you filter based on the town or city on the ticket.
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42 The "Service Area" column filter lets you sort by service area. This filter will be
limited to the service area(s) to which you have access. If you have more than one
service area code, this filter allows you to sort by service area.

43 The "Work Type" column filter allows you to sort tickets by work type.
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44 The "Work Start Date" column filter enables you to filter tickets by their work
start date.

45 The "Company Name" column filter enables you to search and filter for a specific
company name associated with a ticket.
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46 The "Ticket Number" column filter allows for sorting by ticket number in either
ascending or descending order, and is another area where a specific ticket
number can be searched for.

47 On your Ticket Dashboard, each ticket row in the list will also have a 3-dot menu (⋮)
that allows you to open and view the entire ticket, add a positive response to the
ticket, view responses on the ticket, and print the full ticket text.
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48 Suppose the ticket is an older version of a ticket. In that case, meaning the ticket
has either been updated, modified, or the ticket has had a secondary function like
an Excavator Renotification (EXRN), or Relocate/Refresh (RLRF) processed off of it,
there will be a red icon next to the checkbox for the row and the 3-dot menu (⋮) will
also have additional options to "View Most Recent Version" of the ticket and
"Find All Related" tickets.
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49 The "Tickets on Map" section of your dashboard allows you to view tickets for
your service area(s) created within the last 14 days, displayed as points on a map.
This may be helpful for route planning and ticket assigning for locators.

50 The map has features like zoom in, zoom out, search (magnifying glass on the top
left corner of the map), a measurement tool, a 'place a pin' tool, a position to
current location feature, zoom to current location or zoom to view all Tickets on
the map, some oil well and facility map layers, and an aerial imagery map option
as well.
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51 When the icon at the top of the map, which resembles a speech bubble for "Show
map features at the current cursor position," is highlighted in green, it is ON. If
you hover over any of the icons, their names will be displayed. When this is ON, if
you pause your cursor over a ticket pin on the map, some basic ticket information
will be displayed. To turn this feature off, click the speech bubble icon, and it will
change to grey, indicating that it is no longer on.

When the icon at the top of the map, which is a lowercase "i" for "Show map
information for location," is highlighted in green, it is ON. When this feature is
enabled, clicking on a ticket pin on the map will display basic ticket information. To
turn it off, click the "i" icon, and it will change to grey, indicating it is no longer on.
The "i" icon also has a "clear" and "done" option that will display when it is ON as
well.
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52 The map measurement icon looks like a small ruler. If it is highlighted in green,
then it is ON and also includes a "Clear" and "Done" option below it when it is
active and in use. Click once to start the measurement, and double-click to end it.
The line's distance will be displayed on the measurement line(s) that were drawn.
To turn it off, click the measurement tool, then click on the ruler icon. It will
change to grey and will no longer be active.

Right-clicking on the map opens a small menu where you can adjust the
measurement increments used by the measurement tool under "Units".



Made with Scribe - https://scribehow.com 35

53 You can place your own pins on the map as required by using the "Add Push
Pins" icon.

54 The "Position to your Current Location" and "Zoom to your current location"
map features will automatically zoom the map view to your current location,
allowing you to view tickets near your current location in the field. For either of
these features to work, location services on your device must be turned on and
"allowed" for Exactix.
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55 Suppose location services are not enabled on your device. In that case, Exactix will
display a pop-up informing you of the necessary steps to help them, allowing you
to use these features.

56 The zoom to "Tickets" feature will zoom the map view out to show all tickets
within the last 14 days on the map view again.
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57 The map also includes map layers for oil well locations and facilities that can be
turned on or off as needed by clicking the hamburger menu ("≡") on the top right
of the map and checking or unchecking the box. These layers will only be visible
on the map once you have zoomed into an area close enough for them to display.
This hamburger menu also allows you to switch between Street View and
Satellite View.

*** Reviewing Tickets
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58

59 Tickets within Exactix may contain more detailed information than what is
currently delivered to members, so it is always beneficial to review the full ticket
within Exactix.

Select the ticket you want to review and open it by double-clicking anywhere on
the ticket row, or by clicking on the 3-dot menu for the ticket row and selecting
"View Ticket".
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60 The "Ticket" tab within the full ticket displays all the information collected during
ticket submission, as well as a map showing the dig site mapped for the ticket.
The dig site mapping is what triggers the notification to underground facility
owner/operator members. Suppose the ticket's dig site mapping touches the
member's service area registration map that is active in the system. In that case,
that member will receive the ticket.

The map has features like zoom in (+), zoom out (-), search (magnifying glass on
the top left corner of the map), a measurement tool, a 'place a pin' tool, a position
to current location feature (navigation arrow icon), a highlight streets feature
(road icon), as well as some oil well and facility map layers, and an aerial imagery
map option within the hamburger menu ("≡") on the top right of the map. The
map also includes a legend in the bottom left corner of the map.
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61 Right clicking on the map will open a few more map features like; "Units" which
will let you change the increment of measurement for the map measurement tool,
a "zoom to Dig Site", a "Show City/Place" feature, a "Show Service Areas"
feature which will display your Service Area(s) registration area(s) on the map for
reference, as well as another place to zoom in and zoom out.

"Show Service Areas" is a valuable tool for understanding why your Service Area
was notified on a ticket due to the dig site mapping. It will show the dig site
overlapping or touching your Service Areas registration map. If the Dig Site does
not appear to be within your Service Area(s) registration map, then your Service
Area(s) may have been manually added to the ticket at the excavator's request.
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62 Above the map on the "Ticket" tab, there is a "Attachments" tab, which displays
a red number indicating the number of attachments uploaded to the ticket, if any.
This tab will show any excavator attachments that were included with the ticket
when it was submitted under the "Ticket Attachments" section and, if you are
looking at a ticket that is past their locate by date, there may be some positive
response attachments that were uploaded by the members notified on the ticket
with their positive responses under the "Response Attachments" section. The
ticket attachments can be opened or downloaded.

There is also a "QA" tab above the map that indicates whether the Quality
Assurance Department has reviewed the quality of the ticket. This tab will say
"Pending" if the ticket has not been quality checked yet, or it will display a score in
red if it has been QA'd.

The "Help" tab is not currently in use for ticket reviewing.
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63 The next tab in the whole ticket is the "Text" tab. This tab displays the ticket text
and information that was sent to the member. The ticket text can be printed using
the printer icon on the bottom right of the page.

64 The next tab is the "Service Areas" tab. This tab shows all of the member service
areas that were notified on the ticket.
If you click on the "More" next to each Service Area listed, the member's contact
information will be displayed.
Positive Responses can also be posted from this "Service Areas" tab by clicking
the "add new" button under the "Positive Response" column.
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65 The next tab is the "Responses" tab. This tab allows you to post responses by
clicking the "Add New" button under the "Response" column. It will also display
positive responses that have been posted for your Service Area(s) on the ticket, as
well as the ticket events.

The view on the "Responses" tab can be sorted using the "Show" filter check
boxes. "Current Only" will show the most recent positive responses only, the "No
Response" will show your Service Area(s) that have not had a positive reaction
posted yet, and the "All" will show all responses -new, old, and none- for your
Service Area(s). The "Include Events" checkbox will also include the ticket events in
the view.

66 The next tab is the "Deliveries" tab. This tab displays the ticket delivery details
related to the ticket being delivered to your Service Area(s) and its destination.
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67 The final tab in the whole ticket is the "Revisions" tab. This tab displays all
revisions the ticket may have undergone. Revisions are created when the ticket
has been modified, updated, or has had a secondary ticket function processed,
like an Excavator Renotification or a Relocate/Refresh.

*** Posting Positive Response
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68

69 As a member, there are multiple ways to post positive responses to tickets within
Exactix. Explore the different ways below and find what works best for you!
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70 From your Exactix dashboard, click either "Tickets" on the banner on the left side
of the screen or "Go to Ticket Dashboard" to find the tickets for your service
area(s).
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71 Once on the ticket dashboard, you will find a list of all tickets for your Service
Area(s). On the left side, you should see several categories for quick sorting and
viewing of available tickets: Response Due in 48 hours, Past Due, and Tickets on
Map. If you are also an excavator and submit tickets in Exactix, you may also see a
"My Tickets" category in this list. Check out our other training material,
"Members- Reviewing Tickets," for more information on these ticket
categories and steps for thoroughly reviewing tickets within Exactix!

Once you have found the ticket needing a positive response, click on the ticket
row. Clicking anywhere on the ticket row should open the ticket. Alternatively, you
can click on the 3-dot menu (⋮) and select "View Ticket" to open it as well.
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72 Positive Response Posting Method #1 - Posting via the "Service Areas" tab
within the full ticket view.

When the ticket is open for viewing, there are various tabs just under the ticket
information near the top. Click on the "Service Areas" tab.

73 The "Service Areas" tab shows all of the service area codes that were notified on
this ticket. For the Service Areas that you have access to post responses for, you
should see an "add new" link under the Positive Response Column.

Click the "add new" link for the Service Area code you want to post a positive
response to.
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74 A pop-up will appear to "Add Response for Ticket A000000000".

The top required field for "Service Area" will be auto-filled with the Service Area
you clicked the "add new" link for. Next, select the positive response you want to
post from the available responses drop-down in the required "Response" field.
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75 Next, add the Comment that will be uploaded along with the positive response.

Note: If you have picked a positive response that requires a comment to be
added, then there will be a little red asterisk (*) next to "Comment" for that
field. There is a 10-character minimum for required comments.

76 Next, upload your positive response supporting documentation by clicking the
"Select Files" button. This will open the file explorer on your device, allowing you
to browse and find the attachment(s) you want to upload.
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77 Once the file(s) have been uploaded, to the right of the uploaded file, you will see
a link to "open" the attachment for review, "download" the attachment to your
device, and "remove" the uploaded attachment if this is not the correct
attachment that you intended to upload.

Note: Always review the files you have uploaded by "opening" them before
continuing to ensure they are the correct attachments. This is the only time
you can "remove" an uploaded attachment if it is not accurate. After you hit
"save," you will no longer be able to remove any uploaded attachments.
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78 Sample "opening" of the uploaded attachment.
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79 Once you verify that everything on the "Add Response for Ticket A000000000"
pop-up is correct, it needs to be saved.

There are two save buttons:

  • "Save" will save what you have entered into the ticket and close the pop-up

  • "Save & Add Another" will save what you have entered into the ticket and reopen the "Add
Response for Ticket A000000000" for the ticket, allowing you to add another positive response.
This is useful if you have more than one Service Area code on the ticket that you need to
respond to positively.



Made with Scribe - https://scribehow.com 54

80 After saving the response, you should see the positive response posted, along
with the response comments, and the number of attachments that were included
on the row for your service code(s).

There are also options to "view/view all" the attachment(s) that were uploaded,
and an option to "add new," which allows you to add a new positive response to
the ticket for this service code if needed. There is no way to delete a positive
response or attachments that have been saved to a ticket; however, a new
updated positive response can be posted instead.
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81 Positive Response Posting Method #2 - Posting via the "Responses" tab
within the full ticket view.

When the ticket is open for viewing, there are various tabs just under the ticket
information near the top. Click on the "Responses" tab.
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82 The "Responses" tab shows the service area codes that you have access to post
positive responses for, as well as any responses that may have been posted
already.

Click the "add new" link under the "Response" column for the Service Area code
you want to post a positive response to.
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83 A pop-up will appear to "Add Response for Ticket A000000000".

Follow the same steps as before to complete this pop-up.
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84 After saving the response, you should see the positive response posted, along
with the response comments, and the number of attachments that were included
on the row for your service code(s).

There is also an option to "view" the attachment(s) that were uploaded, as well as
an option to "add new," which allows you to add a new positive response to the
ticket for this service code if needed. There is no way to delete a positive response
or attachments that have been saved to a ticket; however, a new updated positive
response can be posted instead.

The "Show" filters can sort responses on the "Responses" tab; "Current Only"
which will show the most recent response posted, "No Response" will show any of
your service area codes that do not have a response posted yet, "All" will show all
posted responses old and new, and "Include Events" will include the events log
rows in the display as well.
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85 Positive Response Posting Method #3 - Posting via the "Add Response"
button in the "Responses" tab within the full ticket view.

When the ticket is open for viewing, there are various tabs just under the ticket
information near the top. Click on the "Responses" tab.

86 A pop-up will appear to "Add Response for Ticket A000000000".

Follow the same steps as before to complete this pop-up.
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87 After saving the response, you should see the positive response posted, along
with the response comments, and the number of attachments that were included
on the row for your service code(s).

There is also an option to "view" the attachment(s) that were uploaded, as well as
an option to "add new", which allows you to add a new positive response to the
ticket for this service code if needed. If there is no "add new" button available,
then the ticket has been canceled.

There is no way to delete a positive response or attachments that have been saved
to a ticket; however, a new updated positive response can be posted instead.
The "Show" filters can sort responses on the "Responses" tab; "Current Only"
which will show the most recent response posted, "No Response" will show any of
your service area codes that do not have a response posted yet, "All" will show all
posted responses old and new, and "Include Events" will include the events log
rows in the display as well.
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88 Positive Response Posting Method #4 - Posting via the 3-dot menu (⋮) next
to the ticket on your Ticket Dashboard.

Find the ticket you want to post a positive response to on your ticket dashboard
and click on the 3-dot menu (⋮) on the left side of the ticket row, then select "Add
Response".
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89 A pop-up will appear to "Add Response for Ticket A000000000".

Follow the same steps as before to complete this pop-up.

90 After saving the response, you should see the positive response code that was
posted listed under the "Current Response" column for that ticket.

You can open the whole ticket and go to the "Responses" tab to fully view the
posted response as well as the response comments, and the number of
attachments that were included on the row for your service code(s).
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91 Positive Response Posting Method #5 - Posting to multiple tickets as once
via the Ticket Dashboard.

Find the tickets that you want to post a positive response to on your ticket
dashboard and select the checkbox for them on the left side of the ticket row.
Select as many tickets as you want, make sure that posting the SAME EXACT
response to all of them is appropriate.

92 Next, click the "Add Response" icon located at the top of the ticket dashboard
ticket list.
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93 Users will receive a pop-up confirming that they are about to post a positive
response to multiple tickets. Click "OK" to proceed.

94 A pop-up will appear to "Add Response for Multiple Tickets," listing the selected
ticket numbers under the "Affected Tickets:" section.

Follow the same steps as before to complete this pop-up.
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95 After saving the response, you should see the positive response code that was
posted listed under the "Current Response" column for that ticket.

You can open the whole ticket and go to the "Responses" tab to fully view the
posted response as well as the response comments, and the number of
attachments that were included on the row for your service code(s).

96 Those are all 5 methods of posting positive responses within Exactix!

*** Ticket Search
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97

98 The Ticket Search List within Exactix can be found from the Ticket Dashboard.

From the Home screen, click on "Tickets" or "Go to Ticket Dashboard" to open the
Ticket Dashboard.
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99 From your Ticket Dashboard, click on "List" in the top right corner of the screen to
open the Ticket Search List.

100 "Ticket Search" will be shown at the top of the page once you are in the Ticket
Search List.

If the ticket number is known, it can be entered into the "Filter by Ticket Number"
field.

The number of tickets shown per page will be set to 25 automatically, but can be
increased to 50 or 100 if needed.
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101 The "Ticket Search" list view will automatically open to "Service Area Ticket
Search," which displays the following columns: Service Areas, Responses Received,
Status, Ticket Number, Version, Function, Ticket Type, Taken Date, Legal Date,
Company Name, Work Done For, and Place.

The "View" of the Ticket Search List can be configured as needed by determining
what columns are shown using the "Configure" option under the "View"
drop-down. Every column displayed is filterable, so determining what column data
is needed to find what you're searching for is crucial.

If you have created and saved previous 'Views', those will also be listed under the
"View" drop-down for selection.
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102 When "Configure" is selected from the "View" drop-down, the "Column Chooser"
configuration window appears on the right side of the screen.

The "Column Chooser" gives you the option to "Create/Copy" new views, to
"Switch" between saved views for editing, or to "Delete" a saved view.

Edit or Copy an Existing Ticket Search List View

103 To copy and edit an existing "View" to create a new view, select the "Create/Copy"
drop-down and choose the "View" that you want to edit. To edit an existing "View,"
select "Switch" and choose the "View" you wish to edit.
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104 Editing an existing view allows you to adjust the current column order for the
columns displayed, change what columns are shown, add new columns to be
shown, and delete columns. The column arrangement from top to bottom on the
configure list is how they will be displayed left to right on the Ticket Search View.

To move a column in the order, click and hold the "Move" icon that is on the left
side of the column name and drag it to the preferred placement.

To delete a column from the list, click on the "Trashcan" icon on the right side of
the column name.
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105 To change an existing column, click on the drop-down arrow on the right side of
the column name and select the column data that you want to be shown instead.
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106 To add a new column to the view, click "Add a column" at the bottom of the
Column Chooser configuration window. Then use the drop-down arrow on the
new blank column field to choose the column data that you would like added.

After the new column has been added, it can then be moved up or down to the
preferred placement in the column list. The column arrangement from top to
bottom on the configure list is how they will be displayed left to right on the Ticket
Search View.

When finished with the edits, the new configuration can be "Saved and Viewed,"
which will save the new view under the "View" drop-down for future use, or the
new configuration can just be "Viewed" without being saved for future use using
the button options at the bottom of the Column Chooser configuration window.

The edits can also be canceled, and the original Ticket Search View will be
unchanged.

Create a New Ticket Search List View
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107

108 To create a new Ticket Search "View", select the "Create/Copy" drop-down and
choose the "New Empty View".
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109 Name your new Ticket Search View and then click on "Add a Column" to start
choosing the column(s) that you want displayed in the new View.
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110 Then use the drop-down arrow on the new blank column field to choose the
column data that you would like added. Repeat clicking on "Add New Column"
until all the new columns wanted have been added.

After the new columns have been added, they can then be moved up or down to
the preferred placement in the column list. The column arrangement from top to
bottom on the configure list is how they will be displayed left to right on the Ticket
Search View.

When finished adding all columns wanted, the new View can be "Saved and
Viewed," which will save the new view under the "View" drop-down for future use,
or the new configuration can just be "Viewed" without being saved for future use
using the button options at the bottom of the Column Chooser configuration
window.

The new View creation can also be canceled.

Setting the Ticket Search List Main Filter
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111
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112 The Ticket Search List will automatically open with the Main "Filter" set to the filter
applied last time the Ticket Search List was opened. The filters "Todays Tickets"
and "Last 30 Days" are shared system filters that will be available for use.

The Main "Filter" of the Ticket Search List can be configured as needed by
determining what filters to set on each of the Ticket Search List columns shown
using the "Configure" option under the "Filter" drop-down. Every column on the
Ticket Search List is filterable, and the Main "Filter" allows you to save a filtered
view without needing to set the filters on each column individually.

If you have created and saved previous "Filters," those will also be listed under the
"Filter" drop-down for selection.

Copy/Edit an Existing Ticket Search List Main Filter
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113 To copy and edit an existing "Filter" to create a new filter, select the "Create/Copy"
drop-down and choose the "Filter" that you want to edit. To edit an existing
"Filter", select "Switch" and choose the "Filter" you wish to edit.
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114 Editing an existing filter enables you to adjust any current filters applied to
columns. Both of the system filters, "Last 30 Days" and "Todays Tickets", set a filter
on the "Taken Date" column, which is the date the ticket was taken into the
system. Columns that have an active filter will display a menu icon above them.

A new column can be added to the current filter by choosing the column to be
filtered from the "Select column to add to filter" field drop-down in the "Filter
Builder" window.

The current filter parameters can also be modified by clicking the "Gear" icon on
the right side of the current filter in the "Filter Builder" window, located under
"Filters".
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115 When a new column is selected to be added to the filter, a separate pop-up
window will appear, allowing you to choose or set the filter options for that
column.

Once a selection is made in the column filter's pop-up, the "Accept" button
becomes clickable. Clicking it adds the new filter parameter to the filters shown
under the "Filters" section in the "Filter Builder" window.

The new column filter selection can be canceled if needed.
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116 The new filter parameter added to the shown filters under the "Filters" section in
the "Filter Builder" window can be modified by clicking on the "Gear" icon, or it can
be deleted by clicking on the "Trashcan" icon, both of which are on the right side
of the new filter addition.

When finished adding all column filters wanted for this filter, the new Filter can be
"Saved and Viewed," which will save the new filter under the "Filter" drop-down for
future use, or the new configuration can just be "Viewed" without being saved for
future use using the button options at the bottom of the Filter Builder
configuration window.

The filter copy/edits can also be canceled if needed.

Creating a New Ticket Search List Main Filter
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117

118 To create a new Ticket Search Main "Filter", select the "Create/Copy" drop-down
and choose the "New Empty Filter".
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119 Name your new Ticket Search Filter and then select a column to be filtered from
the "Select column to add to filter" field drop-down in the "Filter Builder" window.
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120 When a new column is selected to be added to the filter, a separate pop-up
window will appear, allowing you to select or set the filter options for that column.

Once a selection is made in the column filter's pop-up, the "Accept" button
becomes clickable. Clicking it adds the new filter parameter to the filters shown
under the "Filters" section in the "Filter Builder" window.

The new column filter selection can be canceled if needed.
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121 The new filter parameter added to the shown filters under the "Filters" section in
the "Filter Builder" window can be modified by clicking on the "Gear" icon, or it can
be deleted by clicking on the "Trashcan" icon, both of which are on the right side
of the new filter addition.

When finished adding all column filters wanted for this new filter, the Filter can be
"Saved and Viewed," which will save the new filter under the "Filter" drop-down for
future use, or the new configuration can just be "Viewed" without being saved for
future use using the button options at the bottom of the Filter Builder
configuration window.

The filter copy/edits can also be canceled if needed.
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122 When viewing the new Filter, columns with an active filter will display a "carrot"
menu icon above them.

123 Clicking on the "carrot" menu icon above the filtered column will open a separate
pop-up window displaying the filter options for that column. This allows for quick
filter adjustments as needed.

If you happen to clear the filter parameters the Main Filter will have to be
reconfigured.
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124 If the filter parameters in the Main "Filter" view need to be reconfigured, the filter
view will display a red exclamation point to make it noticeable.

To fix, click the drop-down on the Main Filter tab and select "Configure".
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125 Follow the previous steps to use the Filter Builder to select columns to be filtered
and set the filter parameters for those columns, using the "Modify" gear icon if
needed. When finished adding all column filters wanted for this filter
reconfiguration, the Filter can be "Saved and Viewed," which will re-save the new
filter under the "Filter" drop-down for future use, or the new configuration can
just be "Viewed" without being saved for future use using the button options at
the bottom of the Filter Builder configuration window.

The reconfiguration can also be canceled.

Setting Ticket Search Column Filters
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126

127 All of the columns, at any time - in any view, can be filtered by clicking on any of
the column headers. Clicking on a column header, such as "Function," opens a
pop-up displaying the available filter configurations for that column.

Make the wanted filter selections in the pop-up, then click anywhere outside of the
pop-up to close it and apply the selected filter.
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128 Once the filter has been applied, the column(s) with an active filter will display a
"carrot" menu icon above them.

To clear or edit the filters, click on the green column header again to reopen the
column filter pop-up.

*** Support
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129

130
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133 You can access our training portal to register for our selection of live courses.

[[[https://events.zoom.us/eo/Ak5WEB2rzCouxlYzOqVqyG8SHEpPMH31jgr7pVqiCiy
UgWO4_fuf\\\\~AggLXsr32QYFjq8BlYLZ5I06Dg](https://events.zoom.us/eo/Ak5WE
B2rzCouxlYzOqVqyG8SHEpPMH31jgr7pVqiCiyUgWO4_fuf\\\~AggLXsr32QYFjq8BlY
LZ5I06Dg) ]]
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134 https://www.colorado811.org/exactix-ticketing-system

135

https://www.colorado811.org/exactix-ticketing-system
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